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SketchUp Introduction Part i

This chapter will build upon what was covered in the previous chapter. You will
begin to learn how to create geometry and modify it. A very basic introduction will
be presented, with additional information provided later in the book as the need
arises.

Section 4-1
The Basic Entities

Given the amazing images one can create using SketchUp, it is somewhat
surprising that there are mainly just eight types of entities that can be added to a
model.

They are:

e FEdges
e Surfaces

e Annotation
o Dimensions
o Test
o 3D Text

e Components
e Groups
e Guide (reference line)

The next few pages will provide a brief overview of each of these entity types.
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Edges

SketchUp is a face-based program, and all surfaces
(i.e., faces) must be defined by an edge. This is the
fundamental building block of a SketchUp model.

Edges are created with

one of thedraw tools: / Q

e Line
e Circle
o Arc O ﬁ
e Rectangle Edges
e Polygon (\ @ FIGURE 4-1.1 Edges pointed out
e [Freechand ) —
Edges can be created with very specific length (or
radius) or arbitrarily by clicking anywhere within
the drawing window. It is easy to snap to one of Edge

the three planes (axes) while drawing lines. This
makes it possible to draw 3D shapes from a single
3D view (more on this later).

A basic cube has twelve edges. Figure 4-1.1 has 21
edges and Figure 4-1.2 has two edges.

Even circles are made up of small edges. When
one is being created, the Value Contro/ Box (on the
Status Bar) lists the number of sides that will be
used to approximate the circle. This number can FIGURE 4-1.2 Fidge pointed out
be increased to make larger circles smooth, or

decreased to make smaller circles less complex

(which can be a burden on model performance).

Later in this chapter you will get some practice drawing edges and editing them.

Edges can be modified with a number of tools. For example, an edge can be
scaled, rotated, divided, copied, offset and erased. These tools are accessible from
the Tools menu, toolbars (which may not be visible yet), right-click menus (when
the edge is selected) and keyboard shortcuts.

Edges can also be placed on Layers in order to control visibility. A Layer can be
turned off, making everything assigned to that Layer invisible.
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Surfaces

A surface is the second most significant type of entity in SketchUp. You might be
surprised to learn that no tool exists to create a surface! They are created

automatically when the conditions are right.

What are the conditions in which a surface is
automatically created? The simple answer is
when a series of edges form an enclosed
area. When the last edge is drawn which
defines an enclosed area, a surface is created.
This can be as few as three edges — forming a
triangle.

The image to the right (Figure 4-1.3) shows
two examples of three connected edges
defining a surface. Note the edges can be a
combination of straight and curved lines.

If an edge is erased, the surface is also erased,
seeing as it no longer has a boundary.

Su%\

——
L

Surfaces defined by at least three
edges

In addition to edges forming a closed perimeter, there is another important
requirement a new modeler needs to be aware of, That is, all the lines forming

the enclosure must be coplanar.

If you don’t already know, the easiest way to
describe coplanar is to think of all the edges as

lines drawn on a flat piece of paper. As long as

all the lines are in the same plane (i.e., on that
flat piece of paper) a surface will be created.

Surfaces may have materials painted on them.
They can also be placed on Layers in order to
control visibility.

A surface can be deleted; simply
select it and press the Delete key
on the keyboard. The only way to
get another surface is to draw a line
directly on top of one of the

FIGURE 4-1.4
Coplanar on left; not on right

Y.

existing edges. SketchUp will then FIGURE 4-1.5 Another angle of Figure 4-1.4

create a surface and delete the extra
line, as it does not allow two lines
to exist directly on top of each
other.
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Dimensions ¥

Dimensions can be added to your SketchUp model. These are smart entities; they
are not sketched lines and manually entered text. A dimension entity becomes a
permanent part of the model, unlike the Tape Measure tool (which is used to list
distances without drawing anything).

To place a dimension you simply pick three points; the first two are what you want
to dimension and the third is the location of the dimension line and text.
SketchUp automatically displays the correct length.

The dimensions are associative, relative to the first two points picked. The
dimension will grow or shrink if the geometry is modified. However, if the
geometry is deleted, the dimension will remain (but is no longer associated to
anything).

Dimensions can be tricky in that they
may appear correctly and legible
from one angle (Figure 4-1.6a) but
not another (Figure 4-1.6b). But the
visibility of a dimension can be

controlled by Layers ot by Scene
(more on what scenes are later). FIGURE 4-1.6A Dimensions added while viewing
the model from this angle

18 1/16"

To adjust various settings related to how dimensions are created, go to Window
—> Model info and then click Dzmensions in the list on the left.

-

1'81/16"

FIGURE 4-1.6B One dimension still visible when
view angle is changed using orbit

4-4



CHAPTER 4 - SKETCHUP INTRODUCTION - PART II

Text

SketchUp has a tool which allows you to add notes with leaders (i.e., pointing at
something). To place a Text entity you make two clicks and then type (or accept
the default value). Default value? If you point to a surface, SketchUp will
automatically list the area of that surface. If an edge is pointed to, SketchUp will list
its length. An example of each can be seen in the image below (Figure 4-1.7).

If you don’t want a leader, simply click in empty space and you can just type text.
The text “Option A” is an example of text without a leader (Figure 4-1.7).

PREFINISHED METAL FASCIA

~10'33/8"

1182305 Feet 2

EXISTING BRICK

FIGURE 4-1.7 Notes added using the Text tool

Similar to dimensions, text entities remain visible when the vantage point is
changed, using Orbit for example. As you can see in the Figure 4-1.8, this can get a
bit messy. Text visibility can also be controlled with Layers and Scenes like dimensions.

For the most part, notes and dimensions are left until the end of the modeling or
added outside of SketchUp — in LayOut or a CAD program such as AutoCAD or
Revit.
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PREFINISHED METAL FASCIA

Option A

FIGURE 4-1.8 Notes still visible when model rotated using orbit

When text is right-clicked on, a menu pops up which allows you to change the
arrow type and leader (Figure 4-1.9). These options, plus the ability to change the
font, are available via the Entity Info dialog. This can be turned on from the
Window pull-down menu.

The default settings for text can be changed via Window = Model Info, and
then selecting Texz from the list on the left.

Font =
: - - R <
Entity Info ’
/ E v Font: Font style: & Points ™ Height
rase
Regular 12 107
Hide I I I Cancel |
Edit Text Technic
Arrow 3 MNeone TechnicBold
Leader » Dot TechnicLite |
[Tekton Pro -
v | Closed
—Sample
Open

AaBbYyZz
FIGURE 4-1.9
Right-click options for text

FIGURE 4-1.10 Changing font for text entity
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3D Text ‘41

The Text tool, just covered, is meant for notes and comments about the model.
3D Text is meant to be part of the model. This tool is used to model text on signs
or letters on the face of a building. Unlike notes created with the Text tool, 3D

Text stays right where you put it.

Placing 3D Text is easy. Select the tool, and

the Place 3D Text dialog appears (Figure 4-

1.11). Enter your text and select the options
desired for font style, height and thickness

(i.e., extruded). Click OK and then pick a
location on a face to place it.

Once the 3D Text is placed, the Paint Bucket

tool can be used to apply a material.

FIGURE 4-1.12 3D Text placed

Once the text is created, it becomes a
component that cannot be easily edited
(in terms of typing new words).

It is possible to see the properties for
3D Text, or anything else selected, using
the Entity Info dialog (Fig. 4-1.13). This
can be turned on from the Window pull-
down menu. The information presented
varies depending on what is selected.
This dialog can remain open while
modeling.

|

Place 3D Text
BIKE SHOP
Font |Tahoma j IReguIar j
Align |Left = Height |10‘—
Form [ Filled [V Extruded |1‘
Place I Cancel |

FIGURE 4-1.11 Adding 3D Text

Entity Info

]

Solid Component (1in model) B

Layer: ILayern - I
Mame:

Definition Mame:

BIKE SHOP

Volume: I 215.9327 Inches

[ Hidden ¥ Cast Shadows
[ Locked ¥ Receive Shadows

FIGURE 4-1.13 Entity Info dialog

4-7
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Components

In SketchUp one can think of Components being something like clipart in a word
processing program — but clipart on steroids! They are pre-built models which can
be reused in your SketchUp model. Some components are flat 2D models while
others are complex 3D models. The simple, flat components reduce the resources
required of your computer, making it easier to smoothly orbit and inspect your
model. For example, many of the trees designers use in SketchUp are 2D due to
the number typically needed. If 3D trees were used, the file would be large and
unmanageable. The 2D components can be setup so that they always face you —
plus they cast shadows (see Figures4-1.14 and 4-1.15).

FIGURE 4-1.14 2D vs. 3D components; two items are 2D and two are 3D.

Right-clicking on a component allows
you to edit it, explode it (reduce it
down to individual entities) and
add parameters and parametrics
using the advanced Dynamic
Components functionality.

Editing a component causes all
instances of that component, in
your model, to instantly update.
You will see an example of this in
= the next section.

FIGURE 4-1.15 Rotated view of previous image
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One of the truly great things about using SketchUp is the amount of content the
designer has access to. Google hosts a site called Google 3D Warehouse which
has thousands of components ready for the taking.

Components

-+

Dynamic Components Tr._.

& Companents o

FIGURE 4-1.16 Components dialog

The Components dialog (Figure 4-1.10) is the
easiest way to add components to your model.
This can be accessed from the Window menu.
The down arrow highlighted reveals a menu
which provides shortcuts to groups of content,
such as Architecture, People, Playground, etc.

Some of the content found on Google
3D Warehouse is provided directly by
Google, while other content comes
from manufacturers of products (who
hope you will ultimately buy or specify
their products) or from end users like
you.

Of course, users beware on anything one
downloads and uses in their design. As
a design professional (or would-be,
someday, design professional) you are
responsible for code and performance
compliance. So you cannot just assume
the toilet or the door you downloaded
is the correct size. You need to double
check it with the manufacturer’s data
sheets. Now, if the content was created
by the manufacturers, it is highly
probable that it is the correct size.

Components ]|
L+ |

o,

Select | Edit | 5ta

{at | *| pizza jol E}
It is also possible to search for components. You Pizza
. : & v
may be surprised at what you can find. Figure 4- Anpiza n its box. s very
. - | detailed. Some texturesb...
1.17 shows some of the results when searching — oI, meme R
for “pizza”! Notice the author of the component pizza

1s listed directly under the name.

Try a few searches to see what you can find —
maybe try goat, newspaper, or snowboard.

See the next section for more on components.

by ubicundo
g pizza pa Comer, creo g es

de salami, timate, pimiento ...

Pizza
B | hoiade ™

& Results 1 - 12 of about 1038 ]

FIGURE 4-1.17 Components search
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Groups

A Group is similar to a Component in that you can select one part of it and the entire
representation is selected (selecting potentially hundreds of entities with a single
pick). However, that is about all that is the same between them.

. . . Entity Info
Groups are meant for one-off type items. That is, a unique £
. . . . rase
reception desk, a built-in entertainment center, etc. A Component A
is used when your model will contain many instances of an o
Ob]eCt‘ Select

Both Groups and Components are easy to create. You simply Make Component
model something, select it and then right-click (on it). At this
point you can select either Make Group or Make Component

(Figure 4-1.18).

Make Group

NTErSE: aces

Reverse Faces

Flip Aleng

Soften/Smooth Edges
Both Groups and Components can be copied around the model Zoom Extents
(using the Move tool and holding down Cttl). They both can PR

also be edited by right-clicking and selecting “edit” from the
pop-up menu.

FIGURE 4-1.18
Right-click menu

It is important to note that editing a Group only changes the specific Group you are
editing. But editing a Component instantly causes all instances of that Component to
update (see Figures 4-1.20 and 4-1.21). This means SketchUp duplicates all
information required to define each copy of a Group. A single definition is all that
is needed for multiple instances of a Component. Of course, this means a file with
many copies of a Group will be larger than one with many copies of a Component.

The main thing to keep in mind is that Groups are quick and require minimal
decisions. Components can be much more sophisticated and take a lot of time
setting up (creating parameters and parametric relationships, and adding formulas).

When you right-click and select Make Group,

. X . . . Create Component @
SketchUp just makes it without asking any questions.
i A General

It can be selected and named via the Ensity Info Name: [Large Loder
dialog if you wish. Description: [Used in Fire Station design
When creating a Component, the Create Component Algnment
dialog appears (Figure 4-1.19). Notice the various Glue to: [Horizontal v| _Set Component Axes
Options: '|: Cut opening

e Glue to — does the tree stick to the ground r

or ﬂoat in the aer [V Replace selection with component
e Always face the camera — this is ideal for flat Concel | [ create |

two-dimensional items. FIGURE 4-1.19 Right-click menu

® Replace selection — turn the current selection
into one of the Components you are creating.

4-10
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The images below compare what happens when a Component 1s edited versus a
Group. Notice all instances of the Component are updated, whereas only the selected

Group being edited is updated (even though the other Groups are copies of the one
being edited).

|@Q®@

FIGURE 4-1.20 Components vs. groups — components on the left, groups on the right

@EQQ@

FIGURE 4-1.21 Components vs. groups — all components update, only selected group updates

4-11
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Guide

Guide lines (or construction lines) are useful for new users and for a general
design reference grid. The image below (Figure 4-1.22) shows the main 4xes and a

few Guides at 5'-0" intervals. These lines are parallel to the main Axes and are
infinite in length. Note how they converge at the horizon line.

The Tape Measure tool is used to create Guide lines. Follow these simple steps to
create one:

e Start the Tape Measure tool.

e Click on the Edge of any shape or Axes
FYI: Clicking on an endpoint creates a Guide Point.

e Drag the cursor perpendicular to where you want the Guide.
e Release the mouse to locate the Guide.
e Type in alength to (retroactively) adjust the Guide location.

FIGURE 4-1.23 Guides added on top of a surface

4-12
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Guides can be selected and deleted. They can also be relocated with the Move tool.

They can be rotated with the Rofate tool as well.

You can quickly hide the Guides via the I7ew menu Camera Draw Tools

(Figure 4-1.24). Notice the Axes can also be
toggled off/on here as well.

Guides can also be placed on a Layer and hidden.
This would allow you to hide some Guzdes while
leaving others visible. Simply create a Layer using
the Layer dialog (Window = Layers). Then select
the Guide(s) and switch them to another Layer via
the Ewntity Info dialog (see page 4-7).

If you can see Guides on the screen, they will print.

You need to hide them before printing if you do
not want them to print.

< LA«

Toolbars r

Scene Tabs

Hidden Geometry
Section Planes

Section Cuts

Axes
Guides

Shadows

Fog

Edge Style 3
Face Style 3
Component Edit L
Animation r

FIGURE 4-1.24
Guides visibility

4-13
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Section 4-2
Beginning with the Basics

In this section you will practice sketching basic 2D lines and shapes to get the
hang of using a few of the draw and modify tools, as well as specifying specific
dimensions. In the next section you will circle back and see how easy it is to turn
these 2D sketches into 3D drawings.

Setting up the model

The first thing you need to do is start a new model and make a few adjustments.
You will complete these steps for each drawing in this section, unless noted
otherwise (UNO).

1. Start a new SketchUp model using the Architectural Design — Feet and
Inches template.

2. Select the person Component, and press the Delete key on the keyboard.

To break things down into the simplest terms, you will change to a non-
perspective plan (or top) view.

3. From the Camera menu, Tl Tasiile Sigbdibes TRl

select Parallel Projection
(Figure 4-2.1).

Previous
Mext

4. Also from the Camera Standard Views >

menu, select: Standard

. Parallel Projection
Views = Top. : b
v Perspective
You can also go to View =2 Toolbar Two-Point Perspective
= VViews to turn on a toolbar which A A i, Ay
provides quick access to the standard
views (top, front, iso, etc.). FIGURE 4-2.1 Parallel Projection mode

You are now looking at a plan view (Figure 4-2.2). This view is similar to what you
would see on a printed out floor plan (aka, blueprints or construction documents).
Use caution not to press and drag your center wheel button, as this action will
activate the Orbit tool and throw you out of Top view; you would still be in
“paralle]” mode however. If you accidentally do this, simply select “top” again
from the Camera menu. Selecting Undo does not help.

4-14
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Notice how the axes are centered on the screen.

You can adjust which part of the model you are looking at using the Pan tool.
When finished panning, click the Se/ect icon. Do not pan at this time.

f
7/ Untitled - SketchUp [l e =

File Edit View Camera Draw Tools Window Help

| ZBOC(CHRBIHNOF D 2ZAR DL S LD QF

O ® © @ Select objects. Shift to extend select. Drag mouse to select multiple. Measurements

FIGURE 4-2.2 Top view in parallel projection mode

file name: Bookcase

This 1s a simple rectangle that represents the size of a bookcase. The black dot
represents the starting point, which should align with the intersection of the axes.
Do not draw the black dot.

2>y Y

5. Select the Rectangle tool.

£

1 I_O"

4-15
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6. For your first point, click the intersection of the axes (Figure 4-2.3).

a. Be sure your cursor snaps to the Origin; you will see a yellow circle
and a tooltip appear.

7. Select your second point approximately as shown in Figure 4-2.3).

a.  You can keep an eye on the dimension box in the lower right, but do
not worry about getting the number exact as that will be done in the

next step.
Surface Step 7:
automatically Second pick —
created approx. location

Dimensions [4' 4 3/8", 1' & 3/8"
»

\ Step 6: \ Do not worry

First pick — snap about getting
to the Origin exact dimensions

FIGURE 4-2.3 Sketching a rectangle

8. After clicking the second point (step 7) and before doing anything else,
simply type 3',1" and then press Enter.

2. You do not need to click in the Dzmensions box; just start typing.
9. Save your file as Bookcase.skp.
Notice the surface which was automatically created once an enclosed area was

created. You are done with this file for now. You will come back to it later and
turn it into a 3D bookcase.

4-16
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file name: Coffee Table

Next you will start a new file, using
3'-101" the steps previously covered (Setting
2 up the Model; steps 1-4). The
’( 4 previously created file can be closed
and set aside for use in the next
section.

b
9
-

The Coffee Table drawing will
introduce you to entering fractional
~ values.

10. Start a new model, following steps 1-4.

It would be fairly easy to use the Rectangle tool again to draw this item, however
you will use the basic Lize tool so you can see how it works and get practice
entering specific lengths.

/ 11. Select the Line tool from the toolbar.
12. Snap to the Origin (the intersection of the red and green axes).

13. Begin moving your cursor to the right (Figure 4-2.4):

a. Ensure your cursor is “snapped” to the horizontal.
When horizontal, you should see the “On Red Axis” tooltip.

c. Once you are pointing in the correct direction and snapped to the
horizontal, you may type in a length (see the next step for this).

Origin '/7 Tooldp
-------- :

FIGURE 4-2.4 Sketching a line

14. Without moving the mouse, type 3'10.5 and then press Enter.

4-17
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You always have to enter a foot symbol if feet are needed, however the inch
symbol never needs to be typed as it is assumed when nothing is specified.

The Line tool will remain active until you pick the Se/c icon or another tool. Next,
you will draw one of the vertical lines.

15. While the Line tool is still active (Figure 4-2.5):
a. Start moving your cursor straight up.
b. Ensure the “On Green Axis” tooltip is showing; meaning vertical.
c. Type 1'6 and then press Enter.

Seeing this tooltip ensures
you will be sketching an
orthogonal line.

FIGURE 4-2.5 Sketching another line

16. Using one of the alternative methods of entering 3" 10 V2" (see below),
sketch the top horizontal line from right to left.

Entering fractions: the 3'-10%2" can be entered several ways.

3'10.5 Notice there is a space between the feet and inches.
3'10.5 Notice space can also be left out.

3"101/2  Note the two spaces separating feet, inches and fractions.
310 1/2  The second space is always required.

0" 46.5 This is all in inches; that is, 3”-10%2" = 46.5".

46.5 SketchUp assumes inches if nothing is specified.

O O O O O O

T1P: Even when you are in a model using imperial units you can type a metric valne and
SketchUp will automatically convert it. For example; typing 150mm draws a 57 /8" line.

To draw the last line you could type in the value but you can more quickly snap to
the endpoint of the first line drawn. This will complete the rectangular shape.

4-18
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17. Snap to the Endpoint of the first line drawn (Figure 4-2.0).

[

Snap to the endpoint here
‘/ to complete the rectangle.

FIGURE 4-2.6 Completing the rectangle

Once a closed perimeter is defined, as your rectangle, a surface is automatically
created. You should use the Tape Measure tool too occasionally to double check
your lengths. Simply select the Tape Measure tool from the toolbar and then pick
two points in the model. The Va/ue Control Box in the lower right of the
application lists the measurement. Give it a try!

18. Save your file as Coffee Table.skp.

file name: SmallDesk

3'_0 " Next, you will start another new file
I( )| and create this rectangular shape.

19. Create a new model (per
steps 1-4) and create this
small desk using either of the
methods just covered.

K

20. Save your file as
Small Desk.skp.

Don’t worry, things will get more challenging. These steps are laying the

groundwork for all of the 3D modeling you will be doing! So make sure you take
the time to understand this material.

4-19
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file name: Night Table

Obviously, you could draw this quickly per the

' "
1 _6 previous examples. However, you will take a look
)| I( at copying a fi/e and then modifying an existing
model.

b
= You will use the Move tool to stretch the 3'-0"
c? wide desk down to a 1'-6" wide night table.
~—

~ 21. With the Small Desk SketchUp model still

open, select File > Save As.

22. Type Night Table for the File name and click Save (Figure 4-2.7).

 Savehs Es
Savein: ‘ . Data Files j i =
= Name ‘ Date modified Type Size
gy
o |#| Bookcase 11/15/2010 6:02 PM  Google SketchUp ... 49 KB
Recent Places
|#] Small Desk 11/16/2010 8:50 PM  Google SketchUp ... 49 KB
Desktop
Libraries
A
Computer
@
1
Networlk
File name: |m j l_Save
Saveastype: | SketchUp Models " skp) ~]| Cancel

FIGURE 4-2.7 SaveAs dialog

You are now in a new file named Night Table.skp, and are ready to manipulate the
file. The original “small desk” file is now closed and will not be affected.

You will use the Moze tool to change the location of one of the vertical lines,
which will cause the two horizontal lines to stretch with it. SketchUp’s Lznes
automatically have a parametric relationship to adjacent lines when their endpoints
touch each other.

23. Click the vertical line on the right and then select the Move icon on the
toolbatr.

24. Pick the mid-point of the selected line; move the mouse towards the left —
while locked to the vertical (Figure 4-2.8). Do not click yet.

4-20
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Start Point
d ‘\
-

l Line will be red when

snapped to the horizontal

FIGURE 4-2.8 Moving an edge

25. While in the Move command and snapped to the horizontal (ie., red axis),
type 1’6 and then press Enter.

That is it! You essentially just stretched the rectangle. The two horizontal lines
automatically shrunk in length and the surface resized itself as well.

26. Save your Night Table.skp file.

file name: Small Dresser file name: File Cabinet

27. Draw the Small Dresser and the File Cabinet per the previous instructions.

3'-Q" )'1 '_3"'(

f ’1

2'.0"
.
=2y
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file name: Square Chair

30. Use the Move tool to move
the rectangles into position
(Figure 4-

SketchUp does not allow overlapping
lines. Therefore, when you moved the
rectangles into place the lines were
merged, with any endpoints remaining,.
This will allow you to delete the extra

2'_8"

£

)

—

2'_0"

2.10).

Next you will draw this squarish-styled chair.
You could draw this by setting up a few
Guides, but another method will be shown. It
is good to know several ways to accomplish
the same thing as one solution may be more
efficient than another in certain situations.

28. Start with a 2'x2' square aligned with
the origin.

lines identified in Figure 4-2.10.

31. Delete the extra lines

identified in Figure 4-2.10;

29. Draw the backrest and armrests as

separate rectangles, near the square
(Figure 4-2.9).

FIGURE 4-2.9 Creating the chair

select it and press the Delete
key on the keyboard.

When the two lines were removed, the surfaces automatically joined together
within the newly enclosed area (Figure 4-2.11). At this point you only have two
surfaces defined, each of which can be extruded into separate shapes, which you
will do later in the next chapter.

-

—

d

FIGURE 4-2.10

You have completed
the square chair — for
now anyway. You can
save your file and move
on to the next one.

— -

FIGURE 4-2.11

4-22
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Selecting Objects:

At this time we will digress and take a quick look at the various techniques for
selecting entities in SketchUp. Most tools work the same when it comes to
selecting elements.

When selecting entities, you have two primary ways to select them:
o Individually select entities one at a time
o Select several entities at a time with a window

You can use one or a combination of both methods to select elements when using
the Select tool.

Individual Selections:

When using the Sect tool, for example, you simply move the cursor over the
element and click; holding the Ctrl key you can select multiple objects. Then you
typically click the tool you wish to use on the selected items. Press Shift and click
on an item to subtract it from the current selection set.

Window Selections:

Similarly, you can pick a window around several elements to select them all at once.
To select a window, rather than selecting an individual element as previously
described, you select one corner of the window you wish to define. That is, you
pick a point in “space” and hold the mouse button down. Now, as you move the
mouse you will see a rectangle on the screen that represents the windowed area
you are selecting; when the window encompasses the elements you wish to select,
release the mouse.

You actually have two types of windows you can use to select. One is called a
window and the other is called a crossing window.

Window:
This option allows you to select only the objects that are completely within the
window. Any lines that extend out of the window are not selected.

Crossing Window:
This option allows you to select all the entities that are completely within the
window and any that extend outside the window.

Using Window versus Crossing Window:
To select a window you simply pick and drag from /f? to right to form a rectangle.

Conversely, to select a crossing window, you pick and drag from right to left to define
the two diagonal points of the window.
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file name: Square Sofa

L} [1]
6 _2 Similar to how you
|( )‘ turned the Small Desk
into a Night Table, you

will turn the Sguare
Chair into this Square

5!_6" Sofa.

This is a little trickier
as you have to select
multiple lines as part
of the Move command.

32. Once you are sure you saved the Sguare Chair tile,
do a Save As to create the Square Sofa file.

33. Select the three lines shown in Figure 4-2.12.

Moving these lines will cause the horizontal lines to
follow — or stretch, thus growing the chair into a sofal

34. Select Move from the toolbatr. '

35. Pick anywhere in the drawing area and begin '
moving the cursor to the right, snapped to the
horizontal (i.e., on red axis).

36. Without clicking a second point, type the desired
length you wish to move the lines (i.e., stretch *

the sofa); this is the difference between the chair
and the sofa.
FIGURE 4-2.12

Notice how the horizontal lines extended because they
have a parametric relationship to them. The surface has
also updated.

37. Use the Tape Measure tool to double check your dimensions. Make any
corrections needed before moving on.

Keep in mind that all these basic steps will be directly applicable to the more
advanced 3D modeling coming up.

4-24



CHAPTER 4 - SKETCHUP INTRODUCTION - PART 11

file name: Range

2 v 6 "
I( )| Now you will draw a kitchen range with four
circles that represent the burners.

In this exercise you will have to draw

®
temporary lines, called Guides, to create
reference points needed to accurately locate

the circles. Once the circles have been drawn,

O O the Guides can be erased.

38. In a new file, Draw the range with a 2" deep control panel at the back;
refer to the steps previously covered if necessary.

)

39. Use the Tape Measure tool to create
_)| r 1'-4" the four guides dimensioned in Figure
4-2.13.

[ N

a. With the Tape Measure tool

/ \ f— \ active, click and drag on an edge
i \ J \ J to create a Guide parallel to that
- edge.
v /\ /-\ b. Once you let go of the mouse
5 \ J k _/ the Guide is created.

c. Once placed, type the distance
, , and then press Enter to
FIGURE 4-2.13 Adding guides S
position it.
40. Using the Circle tool, draw two 9%2" Dia. circles and two 72"
Dia. circles using the intersections of the Guides to locate the
centers of the circles (Figure 4-2.13).

41. Using the Select tool, select each of the Guides and press the Delete key
on the keyboard to remove them from the model.

Circles are made up of several straight line segments. The default number is 24. If
your circle is large, the number of edges needs to be increased to maintain the look
of a circle. This can be done just before clicking to locate the circle’s center, by
just typing a number and Enter. This number, the radius and Layer can all be
changed at any time using the Enzity Info dialog.

4-25



INTERIOR DESIGN USING
HAND SKETCHING, SKETCHUP AND PHOTOSHOP

file name: Rounded Chair

These last two drawings will involve using
the A tool. The Offser command will also
be utilized.

2'_6"

You will start this chair drawing by sketching
the perimeter and then offsetting it inward.

0
£ ?

42. Draw the three orthogonal lines shown in Figure 4-2.14.

a. The horizontal line is centered on the green axis and aligned with the
red axis.

b. The two vertical lines are 1-3" long. (\

43, Use the Arc tool to add the rounded backrest.
a. Pick the three points shown in Figure 4-2.14.

b. When picking the third point, you should see a “half circle” tooltip
before clicking the mouse button.

Third Pick

\~ Second Pick First Pick

 Tangent at vertex

FIGURE 4-2.14 Sketching an arc
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You now have the perimeter of the chair defined. Next, you will use the Offset
command to create the backrest.

44. Select the Offset tool from the toolbar.
45. Select the arc — just the line, not the surface.

46. Start moving your cursor towards the middle of the chair and then type 4
and press Enter.
47. Draw the two remaining vertical lines.
a. For the first end of the line, snap to the end of the arc.
b. For the second end of the line, snap to a perpendicular point on the

horizontal line.

The 2D version of the chair is now complete. The drawing now has two surfaces,
because two enclosed areas exist: the backrest and the seat area. This will make the
3D extrusion process go smoothly.

file name: Love Seat

This last 2D exercise
will round things off
by making quarter
' " round arcs.
S A

£ )

One thing that is a little tricky here is setting up points to pick before sketching
the arc. When adding an arc it is easiest if the two endpoints are defined by other
line work. Thus, you just have to snap to endpoints for your first two picks and
the third defines the radius. In this example you will need to add two temporary
lines to define the start and end points of the arc.

2'-10"

The radius of the two arcs is 1'-3".
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48. Add the orthogonal lines shown in Figure 4-2.15.

a. All dimensions can be deduced from the information given.

The two 1'-3" lines are temporary and have only been added to aid in sketching
the arcs (which is done in an upcoming step).

- 1I 3II e

ll 3II

&
¥

2I 6II 2I 6II

.
&

FIGURE 4-2.15 Setting things up for the arc tool

49. Delete the two 1'-3" lines.

50. Add one of the perimeter arcs.
a. Pick the two endpoints provided by the orthogonal lines.
b. Move the cursor until the arc is purple and the tooltip reads
“Tangent at vertex” — this will produce a quarter round arc.

51. Add the other arc per the previous step.

Notice that you did not have to specify the radius of the arc because of the
preparation done.

52. Offset the two arcs inward 4" — similar to the rounded chair (Figure4-
2.16).
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FIGURE 4-2.16 Offset perimeter arcs inward 4 inches

53. Complete the backrest and armrests by “connecting the dots” via the Line
tool.

54. Draw the vertical line down the middle, representing the cushions.

Sometimes it is better to extrude a shape into the third dimension before adding
extra line work such as the cushion line. This issue will be explored more in a later

lesson.

Your drawing should be complete (Figure 4-2.17). Note that the drawing has three
surfaces based on the line work you sketched. Don’t forget to save your file.

FIGURE 4-2.17 Completed 2D love seat
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Self-Exam:

The following questions can be used as a way to check your knowledge of this
lesson. The answers can be found at the bottom of this page.

1.

2.

Surfaces are created automatically. (T/F)
Edges cannot be deleted. (T/F)
Circles are made up of several straight lines. (T/F)

A is similar to clipart in a word processing program.

One of the ways you can type 2'-6 V4"

Review Questions:
The following questions may be assigned by your instructor as a way to assess your
knowledge of this section. Your instructor has the answers to the review questions.

8.

9.

Surfaces cannot be deleted. (T/F)
A model can only be viewed in perspective. (T/F)
If the “foot” or “inch” symbol is not entered, inches are assumed. (T/F)

For repetitive items it is better to use a Group rather than a Component.

(T/F)

Text and dimensions can be a little tricky to maintain in a 3D model.
(T/F)

lists a length without actually drawing anything.

When reference lines are needed, you can add

Layers help to control visibility of entities in your model. (T/F)

Used to see the properties of 3D text:

10. Three picks are required to sketch an arc. (T/F)

Self-Exam Answers:
1-T,2-F,3-T,4- Component, 5 —2'6.25
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